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Introduction

About the wavestate Editor/Librarian
The wavestate Editor/Librarian lets you organize and edit data on a wavestate connected to a Mac or Windows 
computer via USB, and transfer sound data back and forth between the wavestate and the computer. 
For instance, you can:
• Edit Set Lists, Performances, Programs, Wave Sequences, and Wave Sequence Lanes
• See the progress of sequences and the results of modulation in real-time
• Back up and restore all of the wavestate’s data
• Use Import and Export to transfer sounds to and from your computer, from one wavestate to another, and to and 

from the wavestate native plug-in
• Edit metadata for user sounds (Set Lists, Performances, Programs, Wave Sequences, and Wave Sequence Lanes), 

including the Name, Categories, and Collections (as shown on the wavestate’s display), as well as addi tional meta-
data including the Author and per-sound notes

Think of the Editor/Librarian as an external display for the wavestate
Important: It’s best to think of the Editor/Librarian as an external display for the wavestate, instead of as a 
separate program. Everything that you see in the Editor/Librarian’s main and Set List windows is actually 
stored on the connected wavestate.

When you make edits or import data with the Editor/Librarian, you are directly editing the data on the connected 
wavestate. The Editor/Librarian can export data to your computer (for backup, or for transferring to another 
wavestate), but it has no data of its own. This also means that the Editor/Librarian cannot be used “off-line;” it only 
functions when connected to a wavestate.

Changes in Editor/Librarian version 1.1
wavestate owners are eligible for a significant discount on the wavestate native plug-in, via a coupon code tied to the 
wavestate hardware’s unique ID. wavestate Editor/Librarian version 1.1 adds support for generating these coupon 
codes, support for Wave Sequence Step Solo, and other minor improvements. wavestate software version 2.1.0 is 
required.

Cautions
Do not disconnect your wavestate from USB, or turn its power off, while the Editor/Librarian is running. 
Do not operate your wavestate while data is being transmitted.

Operating requirements
To use the wavestate Editor/Librarian, you need a wavestate running software version 2.1.0 or later, a USB cable, and a 
USB-capable Mac or Windows computer that satisfies the requirements below.
Note: Full functionality is not necessarily guaranteed with all computers, even if they satisfy these system requirements.

MacOS
Operating system: Mac OSX 10.12 or later, including macOS 11 and 12.

Windows
Operating system: Windows 7 SP1 or later, including Windows 8,Windows 10, and Windows 11. 64-bit versions only; 
32-bit versions are not supported. Touch panel operation is not supported.
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Installation
wavestate software version 2.1.0 or later is required
Check the software version of the wavestate:
1. Press UTILITY and then SHIFT + < (PAGE -).
This will take you to the About page. The version number is shown at the top of the screen. If the version is 2.0.1 or 
earlier, you’ll need to update the wavestate before continuing. The latest wavestate software can be downloaded from 
the Korg website (http://www.korg.com/ ). 

What’s installed on my computer, and why?
The Editor/Librarian communicates with the wavestate using networking over USB, as opposed to MIDI. To 
automatically identify and connect with the wavestate over the network, the Editor/Librarian uses the mDNS standard. 
On Windows, this requires Apple Inc.’s Bonjour, and so this is installed along with the Editor/Librarian application. 

USB Network setting
The USB Network parameter is on the MIDI & USB page. To get there:
1. Press UTILITY twice, and then hold SHIFT and press > (PAGE +).
If this page is named MIDI, and the USB Network parameter does not appear, please update to wavestate software 2.0 
or later before proceeding.

USB Network
[RNDIS, NCM]
RNDIS: This is the RNDIS protocol, primarily for use with Windows 7 and 8.
NCM: This is the Network Control Model protocol, for use with MacOS and Windows 10.

Important: Changes to this parameter take effect only after the wavestate has been turned off and restarted.

MacOS
To install the software on MacOS:
1. On the wavestate, make sure that the USB Network parameter is set to NCM.
For more information, see “USB Network” on page 2. If you change the setting, restart the wavestate before 
proceeding.
2. Connect your wavestate to the computer via USB.
3. Open the wavestate Editor/Librarian [version number] .dmg file in the Finder. 
The disk image will open.
4. On the disk image, open the wavestate Editor/Librarian [version number] .pkg file.
The installer will start.
5. Follow the on-screen instructions to complete the installation. Enter your administrator password when 

prompted.
The installation will run, and the Editor/Librarian application will be installed in Applications/KORG/wavestate.
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Windows
To install the software on Windows:
1. Double click “Korg wavestate Editor/Librarian [version number] Installer.exe.”
The installer will start. 
2. Follow the on screen instructions to complete the installation. 
The installation will run. Two separate items are installed: Apple Inc.’s Bonjour, which allows the computer to 
communicate with the wavestate through USB Networking (see below) and the Editor/Librarian application.
3. After the installation is complete, if you have not already configured the NCM or RNDIS driver, do so now.
The wavestate uses either NCM or Microsoft’s RNDIS to communicate with the computer. If you’ve had to update the 
wavestate software, you’ll already have done this configuration, and can simply launch the Editor/Librarian and get 
going! Otherwise, follow the instructions below. Note that the process works slightly differently for Windows 7, 8, and 
10. 
In some cases, the wavestate may not be immediately recognized after installation. If this occurs, simply restart your 
computer.

RNDIS configuration: Windows 7
After connecting the wavestate to a Windows 7 computer, there will be new entries in the Device Manager under 
“Other Devices” and also under “Sound, video and game controllers.”
1. On the wavestate, make sure that the USB Network parameter is set to RNDIS.
For more information, see “USB Network” on page 2. If you change the setting, restart the wavestate before 
proceeding.
2. Plug in the USB cable from the wavestate.
3. Open the Start Menu, and select Control Panel.
The Control Panel opens.
4. Click on Hardware and Sound.
The Hardware and Sound window appears.
5. Under Devices and Printers, click on Device Manager.
The Device Manager appears.
6. Confirm that a new RNDIS device is present under “Other devices.” 
7. Right click on the new RNDIS device and select “Update Driver Software”.
8. Click “Browse my computer for driver software.”
9. Click “Let me pick from a list of available drivers on my computer.”
10. Select “Network Adapter” for the device type and click “Next.”
11. Select “Microsoft Corporation” for the Manufacturer and click “Next.”
12. Select “Remote NDIS Compatible Device” for the Model and click “Next.”
A pop-up window titled “Update Driver Warning” appears. 
13. Click “Yes” to continue installing the driver.
Wait for the process to complete, and close the window when done.

RNDIS configuration: Windows 8
After connecting the wavestate to a Windows 8 computer, there will be new entries in the Device Manager under 
“Other Devices” and also under “Sound, video and game controllers.”
1. On the wavestate, make sure that the USB Network parameter is set to RNDIS.
For more information, see “USB Network” on page 2. If you change the setting, restart the wavestate before 
proceeding.
2. Plug in the USB cable from the wavestate.
3. Open the Device Manager.
There are various ways to do this, but the easiest is from the Power User Menu:
• Press the WIN (Windows) key and the X key together.
• The Power User Menu appears.
• Select Device Manager from the menu.
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The Device Manager appears.
4. Confirm that a new RNDIS device is present under “Other devices.” 
5. Right click on the new RNDIS device and select “Update Driver.”
6. Click “Browse my computer for driver software.”
7. Click “Let me pick from a list of available drivers on my computer.”
8. Select “Network Adapter” for the device type and click “Next.”
9. Select “Microsoft” for the Manufacturer and click “Next.”
10. Select “Remote NDIS Compatible Device” for the Model and click “Next.”
A pop-up window titled “Update Driver Warning” appears. 
11. Click “Yes” to continue installing the driver.
Wait for the process to complete, and close the window when done.

NCM configuration: Windows 10
1. On the wavestate, press UTILITY twice and then make sure that the USB Network parameter is set to NCM.
For more information, see “USB Network” on page 2. If you change the setting, restart the wavestate before 
proceeding.
2. Plug in the USB cable from the wavestate.
3. Open the Device Manager.
There are various ways to do this, but the easiest is from the Power User Menu:
• Press the WIN (Windows) key and the X key together.
• The Power User Menu appears.
• Select Device Manager from the menu.
The Device Manager appears.
4. Confirm that a new NCM device is present under the “Other devices” heading. 
5. Right click on the new NCM device and select “Update driver.”
6. Click “Browse my computer for driver software.”
7. Click “Let me pick from a list of available drivers on my computer.”
8. If necessary, select “Network Adapter” for the device type and click “Next.” Otherwise, skip to the next step.
9. Select “Microsoft” for the Manufacturer.
10. Select “UsbNcm” for the Model and click “Next.”
A warning may appear: “Installing this device is not recommended.” If so, press “Yes” to continue.
Wait for the process to complete, and close the window when done.
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Using the Editor/Librarian

Starting the wavestate Editor/Librarian
1. Install the software and connect the wavestate via USB, as described under “Installation” on page 2.
A USB connection is required. 
2. Start the wavestate Editor/Librarian.
You can find the wavestate Editor/Librarian application in the following locations, depending on the operating system 
being used:
In MacOS, the wavestate Editor/Librarian is installed into Applications/KORG/wavestate.
In Windows, you can find the wavestate Editor/Librarian under KORG/wavestate in All Programs, the Start Menu, etc.

Using the Editor/Librarian with two or more wavestates
Important: Before connecting multiple wavestates, make sure to set each instrument’s System ID to a different 
number. 

To set the wavestate’s System ID:
1. Press the UTILITY button to go to the System Setup page.
If a different page appears at first, press UTILITY again.
2. Set the System ID parameter, at the bottom of the page, as desired.
The specific number isn’t important; just make sure that all connected wavestates have different System IDs.
3. In the wavestate Editor/Librarian, use the Devices menu to select the desired wavestate.
Note that data cannot be copied directly from one wavestate to another; instead, use Export to save the data from the 
first wavestate, and then Import to load the data into the second wavestate.

Two modes: Editor and Librarian
The buttons in the upper right of the main window select whether you’re working with the Editor or the Librarian. For 
the most part, you can simply switch between the two without thinking about it. It’s important to note, however, that 
some menu commands may be available only in one mode, and that undo is handled separately for each mode.

Menu commands
In general, menu commands for file operations, such as importing, exporting, backing up, and restoring, are available 
only when the Librarian is active. Similarly, menu commands for saving Performances are available only when the 
Editor is active.

Undo/Redo
The wavestate Editor/Librarian supports multiple levels of undo and redo for most actions, including importing 
data, deleting, renaming, editing Set Lists, editing parameters, and so on. For instance, you could import a bundle file 
containing a thousand objects, and then rename all of your Programs, and safely undo both actions in turn. Note that 
restoring from a backup is not undoable.
Undo/redo buffers are maintained separately for the Librarian and Editor modes. You’ll see this in the menu 
commands, whose names change based on the mode to either Librarian Undo/Redo or Editor Undo/Redo, 
respectively.
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Using the Editor

Basic use
Note: This manual describes how to use the Editor application. For details about how to use the wavestate, and how its 
functions and parameters work, please see the wavestate Operation Guide.

Knobs and sliders
To edit knob values, drag vertically, or use the mouse wheel or drag on the trackpad.
To edit slider values, drag in the direction of the slider. Most sliders also support the mouse wheel or dragging on the 
trackpad; parameters that appear in scrolling lists (such detailed effects editing) are an exception.
Double-click knobs and sliders to center them.

Graphic editing
Envelopes, LFOs, Key Zones, Key & Velocity Zones, and Master EQ can be edited directly in their respective graphics. 
To do this:
1. Hover the cursor over the graphic to show a colored handle (either a dot or a line).
2. Drag the handle to edit the value.
For Envelopes, there are handles for Curve in the middle of the A/D/R segments. 
For Key & Velocity Zones, option-drag to edit the fade zone.

Selecting, saving, and renaming sound data in the Editor
Performances contain many smaller pieces of sound data, including Programs, Wave Sequences, Wave Sequence Lanes, 
and Effects Presets. You can save and rename these directly from the Editor. To do so:
1. Click the sound data’s name to open the selection dialog.
You can save and rename Programs, Wave Sequences etc. directly from the Editor. To do so:
1. Right-click on the sound data name to bring up the contextual menu.
2. Select Save, Save As New, or Rename, as desired.

Copy/Paste
You can use copy/paste with:
• Layers
• Programs
• LFOs
• Envelopes
• Vector Envelope
• Filter & Amp Key Track
• Mod Processors
• Individual effects (Pre FX, Mod FX, Delay, Reverb, and Master EQ)
• Filter settings
• Arpeggiator settings
For example, you can copy from one LFO to another in the same Program, or copy the Filter or Arpeggiator settings 
from one Layer to another. 
To use copy and paste with any of the above:
1. Right-click (or control-click on MacOS) on the title of the section that you’d like to copy, such as Filter LFO, 

Arpeggiator, or Mod Processor 2.
A contextual menu will appear.
2. Select Copy from the contextual menu.
3. Right-click (or control-click on MacOS) on the title of the section to which you’d like to Paste.
Note that this has to be the same type as the copy source; for instance, you can’t copy an LFO to an Envelope.
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4. Select Paste from the contextual menu.

Copy/Paste for Wave Sequence Steps
Wave Sequence Steps support Copy and Paste, as well as Cut, Insert Before, Insert After, and Delete. Shift-click to 
select a range of Steps, or select multiple non-continuous items by holding down the Command key on MacOS, or the 
Ctrl key in Windows. Once you’ve selected the desired step(s), right-click (or control-click on MacOS) to bring up the 
contextual menu and choose the desired copy/paste operation. 
If you have cut or copied multiple steps, and then select a range of steps as the Paste destination, the following will 
happen:
• If a single step is selected, the steps will be pasted starting at that step, and then replace as many steps as necessary 

following that step. 
• If you’ve selected exactly the same number of steps as are on the clipboard, even if they are discontiguous, Paste 

will replace only those selected steps.
• If you’ve selected fewer steps than are on the clipboard, even if they are discontiguous, Paste will replace the select-

ed steps, and then replace as many steps as necessary following the last selected step. 
• If you’ve selected more steps than are on the clipboard, Paste will replace the selected steps with a loop of the clip-

board, stopping at the last selected step.
If you select a range of steps as the Insert Before or Insert After destination, only the first or last step matters. Insert 
Before refers to  the first selected step, and Insert After refers to the last selected step.
If the Lane doesn’t already contain enough steps to complete the paste operation, more will be added to the end, up to 
the maximum of 64.

Wave Sequence editing

Wave Sequence
Inspector

Wave Sequence Inspector
This area shows details for the currently selected Lane or Step.
To edit Lane parameters, click on the Lane’s title. To edit Step parameters, click on a Step.

Changing the number of displayed steps
Use the 16/32/64 step buttons to adjust the viewable range of the display, to show 16, 32, or 64 steps, respectively.

Editing Start, End, and Loop steps
The triangles above the Steps show the Loop Start (green) and Loop End (red). The triangles below the Steps show the 
Start (green) and End (red). To edit, just click and drag on the triangles.

Editing values on the Step graphics
For the Pitch, Gate, and Step Sequence lanes, as well as the Timing Lane when Tempo is off, drag on Steps in the graphic 
to edit the Transpose, Gate time, Step value, or Duration, respectively.
For the Sample and Shape lanes, as well as the Timing Lane when Tempo is on, click and hold to bring up a popup menu 
to select the Multisample, Shape, or note value, respectively.
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Solo Step
Step solo mode makes the Lane temporarily loop on the selected Step, for auditioning Multisamples or shapes, 
troubleshooting, etc.
To enter Step Solo mode:
1. Right-click or control-click (macOS) on a Step to bring up the contextual menu.
2. Select the Solo Step command.
The Step will be marked with a yellow outline.
The Wave Sequence will play as if that Lane was set to loop on the selected Step. Other Lanes will continue to play 
normally. If you select other Steps in the current Lane, solo will follow the selected Step.
To exit Step Solo mode, bring up the contextual menu and un-select Solo Step.
Only one Lane at a time can be in Step Solo mode. If you enter Step Solo mode for a second Lane, the first Lane’s Step
Solo mode is turned off automatically. Changing to a different Layer also turns off Step Solo mode.

Modulation
The Editor shows real-time modulated values as orange dots on knobs and sliders. If a parameter is shown only as a text 
or numeric box, and it is modulated, the text is shown in orange.

Modulation inspector
The modulation inspector in the upper right shows the modulation routings, if any, for the selected parameter (marked 
by an orange box). You can also add new modulations or delete existing ones. 

Drag and drop modulation routings
To create a modulation routing using drag and drop:
1. Click on the name of any of the following: the Mod or Pitch wheel, Mod Knobs, Kaoss Physics, Envelopes, 

LFOs, Filter or Amp Key Track, or Mod Processors.
For the Mod Knobs and wheels in particular, make sure to click on the name, and not the control or value display! 
2. Drag to a modulation destination.

Modulating one mod source with another
You can also drag-and-drop to modulate one mod source with another. To create this sort of routing via drag-and-drop:
1. Click on the name of the mod source, as above.
2. Drag and hold over the tab for the desired modulation destination. 
For example, to modulate the Filter LFO, hold over the LFOs tab.
After a moment, the tab will open.
3. Once the tab opens and displays its contents, drag to the desired destination. 
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Effects
Using the Editor, you can edit internal effects parameters and save Effects Presets.
Press the EDIT button next to the effect name to show the full list of effects parameters.

Modulation of internal parameters is allowed only from the FX Edit 1/2/3 knobs. To modulate effects from other 
sources, such as the Mod Wheel or the Mod Knobs, assign the internal parameter to one of the FX Edit knobs, and then 
modulate the FX Edit knob from the desired source.
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Using the Librarian

Import and export
Import and export let you transfer data between the wavestate and the computer. This lets you import new sounds, 
transfer sounds from one wavestate to another (and to and from the wavestate native plug-in), or back up and restore 
specific data. (For backing up the entire contents of the wavestate, see “Backup and restore” on page 11.)

Important: make sure to read “Think of the Editor/Librarian as an external display for the wavestate” on 
page 1.

Importing data
To import data from your computer to the wavestate:
1. In the File menu, select the Import… command.
A standard file open dialog will appear.
2. Select the wavestate file(s) to import.
You can select and import multiple files at once.
3. Press the Open button.
The data in the file(s) will be imported into the wavestate. A message will appear to confirm the import, including 
information about which files have been added. 

Data conflicts
If some of the imported data appears to be different or updated versions of the internal data, a dialog will appear with 
the text:
“A different or changed item already exists in the database for <item name>”
The dialog offers several options:
Cancel: the item will not be imported.
Overwrite: the item will be imported, replacing the version in the wavestate.
Make Unique: the item will be imported, and its UUID (see “UUIDs” on page 10) will be changed so that it does not 
conflict with the version already in the wavestate.
Apply to All: the choice of Cancel, Overwrite, and Make Unique will be applied to all conflicting files in the Import.
If a Set List is imported, and some of its constituent Performances were made unique, then the Set List is edited to point 
to the new Performances.

UUIDs
The wavestate uses a database to keep sounds organized. Internally, sounds are identified not by their names, but rather 
by a unique tag attached to the file, called a UUID (“Universally Unique Identifier”). This means that even if a sound’s 
name has been changed, the system still knows it’s the same sound. 
When you write a sound from the wavestate front panel, “Overwrite” keeps the UUID the same, and “Save As New” 
creates a new UUID.
When you import data, the UUIDs in the sounds to be imported are compared with those already in the database. If 
a sound has the same UUID, but its contents are different, you’ll see the dialog described under “Data conflicts” on 
page 10.

Exporting data
When exporting two or more pieces of data, you can either save them as separate files or as a single Bundle file.

Exporting as separate files
To export data from the wavestate to your computer as separate files on disk:
1. In the Main Window, select the data that you’d like to export.
For more information, see “List and selection” on page 15.
2. In the File menu, select the Export… command.
A standard file open dialog will appear.
3. Navigate to the location to save the files.
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4. Press Open to select the current directory and save the files.

Exporting as a bundle
To export multiple pieces of data from the wavestate to your computer as a bundle:
1. In the Main Window, select the data that you’d like to export.
2. In the File menu, select the Export Bundle… command.
3. Navigate to the location to save the bundle, and enter a name for the file.
4. Press Save to save the bundle file.

Importing and exporting Set Lists
Set Lists refer to up to 64 Performances. When you export a Set List, both the Set List and its referenced Performances 
are saved together. This makes it easy to transfer groups of sounds between two or more wavestates.

File Types
The wavestate Editor/Librarian uses the file types below.

Type Extension Contents
Performance wsperf

A single item of the specified type.

Program wsprog

Scale wsscale

Wave Sequence wswaveseq

Master Lane wsmasterln

Timing Lane wstimingln

Sample Lane wssampleln

Pitch Lane wspitchln

Gate Lane wsgateln

Shape Lane wsshapeln

Step Seq Lane wsstepseqln

Set List wssetlist One Set List and all of its referenced Performances

Bundle wsbundle Multiple items of any type.

Backup wsbackup The entire contents of the wavestate.

Backup and restore
Backing up all data
1. In the File menu, select the Backup… command.
The Main Window will change to show the Backup window.
2. Enter a brief descriptive note.
3. If desired, enable the Include User Sample Bank option.
If this box is checked, the current User Sample Bank will be included in the backup file. Note that this can significantly 
increase both the size of the backup file (up to 4 GB!), and the time required to complete the backup.
4. Press Start to begin the backup, or Cancel to return to the Main Window.
A progress bar shows the status of the backup, and a message appears when the backup is complete.
5. Press the Done button to return to the Main Window.

Restoring data
Important: Restoring from a backup will delete all of the data currently in the wavestate. If a subset of the data 
types is selected during the restore, only the data of the selected types will be deleted.

1. In the File menu, select the Restore… command.
A standard file open dialog will appear.
2. Select the wavestate backup file to use for the restore.
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The Main Window will change to show the restore dialog. This shows the text note stored with the file, and includes a 
series of check-boxes to select the types of data which will be restored. By default, all data types are selected except for 
Calibration Data and the User Sample Bank.

Important: Only select Calibration Data when restoring to the identical physical instrument which created 
the backup. Otherwise, leave it un-checked.

3. If desired, select the types of data to restore.
4. Press Start to begin the restore, or Cancel to return to the Main Window.
A progress bar shows the status of the restore, and a message appears when the restore is complete.

Tip: Merging data
If you want to merge your current state with a previous state, use Export and Import instead. If you have a backup file 
and want to merge it with your current state, first Export all data, then restore from the backup, and then re-Import the 
data. 

Editing Set Lists
With the Editor/Librarian, you can:
• Duplicate Set Lists
• Add Performances to Set Lists via drag-and-drop
• Re-arrange, cut, copy, and delete the Slots in a Set List
• Copy from one Set List to another

Duplicating Set Lists
To duplicate a Set List:
1. In the Main Window, select one or more Set Lists.
It may help to select the Set Lists tab first, so that only Set Lists are shown. For more information, see “Main Window” 
on page 14. 
2. In the Edit menu, select the Duplicate command.
You can also right-click on the Set List in the Main Window and use the contextual menu.
The selected Set List(s) will be duplicated, with a number appended to their name.

Adding Performances to a Set List
To add Performances to a Set List:
1. Open a Set List window.
With the default Preferences settings, you can open the window by double-clicking on a Set List in the Main Window. 
For more information, see “Preferences” on page 18.
2. Select one or more Performances in the Main Window.
3. Click and hold on a selected Performance, and drag it over a Slot in the Set List window.
The Performance will be pasted over the Slot. If you’re dragging multiple Performances, they will be pasted over the Slot 
and immediately subsequent Slots, as necessary.

Re-arranging Slots in a Set List, or copying from one Set List to another
You can re-arrange the Slots in a Set List, such as using cut, copy, paste, and insert, using three different methods:
• Commands in the Edit menu
• Commands in the pop-up contextual menu (right-click, or control-click on MacOS)
• Drag-and-drop
You can open multiple Set List windows at once. If one of the windows shows the Set List currently selected on the 
wavestate, the note “(Active)” appears after its name in the title bar.

Using commands in the Edit menu or contextual menu
To re-arrange Slots using the Edit menu:
1. Select the Slots that you’d like to copy, cut, or delete.
You can select two or more non-continuous Slots using command-click on MacOS, or Ctrl-click in Windows. 
Alternatively, select a continuous range of Slots by using Shift-click.
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2. Select the Cut, Cut and Shift Slots, Copy, or Delete command, as desired.
You can either select the commands from the Edit menu, or bring up the contextual menu by right-clicking/control-
clicking on one of the selected Slots. For details on how these work, especially Cut and Shift Slots, see “Edit menu” on 
page 19.
If you delete a Slot, its contents are replaced by the Init Performance.
If using Paste or Insert Before, continue:
3. Select the destination Slot.

Important: if multiple Slots are selected, only the lowest-numbered selection affects the Paste or Insert Before 
operation; other selections are ignored. For more information, see “Paste” on page 19 and “Insert Before” on 
page 20.

4. Select the Paste or Insert Before command, as desired.

Using drag-and-drop
To re-arrange Slots using drag-and-drop:
1. Select the Slots that you’d like to copy or cut.
2. Click and drag on top of a Slot to Paste, or to the space between Slots to Insert Before.
The effect on the original Slots depends on whether or not you hold the Option key (MacOS) or Alt key (Windows), 
and whether you’re dragging within a single Set List or from one Set List to another, as shown in the table below.

Destination Drag action Edit action Affect on Original Slots

Same Set List

On top of a Slot Paste Changed to Init Performance

On top of a Slot, holding Option/Alt Paste Remain unchanged

Between Slots Insert Before Removed, as with Cut and Shift Slots

Between Slots, holding Option/Alt Insert Before Remain, shifted down with the rest of the Slots

Different Set List
On top of a Slot Paste

Original Slots always remain unchanged
Between Slots Insert Before

Note that dragging to a different Set List always leaves the original Slots intact; option-drag is not required.
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Windows
This section provides a brief explanation of the wavestate Editor/Librarian’s screens and their functions.

Main Window
This is the central window for the wavestate Editor/Librarian. It has two basic states, controlled by the buttons at the top 
right: Editor and Librarian.

Librarian
This shows lists of all the data on the connected wavestate.

Librarian Window

Current Performance

Data type tabs
Metadata columns 
(drag to re-arrange)

Show/Hide Search �eld 
Inspector panel

LIBRARIAN and EDITOR buttons

List shows contents of wavestateLock icon = Factory Data Inspector 

Current Performance
This shows the Performance currently active on the connected wavestate. This will update if you change the 
Performance on the wavestate, or if you select a Performance using the Editor/Librarian. For more information, see 
“Performance Selection” on page 18.

Show/Hide Inspector panel
This button controls whether or not the Inspector panel is shown (see “Inspector” on page 15). You can hide the 
Inspector to create space for more and/or wider metadata columns.

LIBRARIAN and EDITOR buttons
The buttons in the upper right of the main window select whether you’re working with the Editor or the Librarian. 
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Search Field
This filters the list by searching for text in any of the metadata fields.

Lock icons: factory data is write-protected
All of the data shipped from the factory is write-protected, including Performances, Programs, Effects presets, and so 
on. This is shown by the lock icons in the list and at the top of the Inspector panel. Factory sounds can’t be deleted, and 
their original versions can’t be changed, including metadata such as name, author etc. However, you can duplicate them 
and then edit however you’d like. 

Data type tabs
The list can show the Performances, Programs, Wave Sequences, Wave Sequence Lane presets, Scales, Effects presets, 
and Set Lists on the connected wavestate. These tabs choose which type(s) of data are shown in the list. All Data shows 
all types of data at once.

Metadata columns
For each item, the list shows the Type, Name, Collection, Category, Author, and Notes, as well as whether or not the 
item is locked factory data. You can drag the top of the columns to re-arrange them, or to resize the columns. 
Click on a column heading to sort; click again to reverse the sort order. The triangle icon shows which column is 
selected for sorting, and the direction of the triangle (up or down) shows the sort order.
The numbers on the left are only intended for navigating in the list, and will update depending on the way that the list is 
sorted. Individual items do not have fixed numbers.

Inspector
This panel lets you view and edit the metadata for the selected items, including the Name, Collection, Categories 1 & 2, 
Author, and Notes. If more than one item is selected, and the items have different settings for a metadata field (such as 
the name or category), the field shows the note “<Multiple Values.>”
If the lock icon is shown, the selection includes factory data, and the fields cannot be edited. You can, however, copy 
text to paste elsewhere.
The Inspector panel can be hidden or shown by using the Show/Hide Inspector panel button in the upper right corner 
of the window, and can be resized by dragging its left edge.

List and selection
This list shows the contents of the connected wavestate, as filtered by the data type tabs and search field.
Click on an item in the list to select it. Selecting Performances and Set Lists can, optionally, also select them on the 
connected wavestate. For more information, see “Preferences” on page 18.
Select multiple non-continuous items by holding down the command key on MacOS, or the Ctrl key in Windows. You 
can also select a range of items by using Shift.
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Editor
This shows the parameters for the current Performance.

Editor Window

Modulation InspectorCurrent Performance

Layers A-D

Wave Sequence
Editor

Wave Sequence
Inspector

LIBRARIAN and EDITOR buttons

Keyboard, 
Mod Sources, 
and E�ects tabs

Current Performance
This shows the Performance currently active on the connected wavestate. This will update if you change the 
Performance on the wavestate, or if you select a Performance using the Editor/Librarian. For more information, see 
“Performance Selection” on page 18.

Modulation Inspector
This shows the modulation routings for the selected parameter. You can add or delete routings from the list, and add 
Intensity Modulation to existing modulation routings.

LIBRARIAN and EDITOR buttons
The buttons in the upper right of the main window select whether you’re working with the Editor or the Librarian. 

Layers A-D
These tabs select which of the Layers will be shown, and whether they are on (button lit green) or off. 

Wave Sequence Editor
This area lets you select and edit the Wave Sequence Steps, and view the Wave Sequence in real-time.

Wave Sequence Inspector
This area shows the parameters for the selected Wave Sequence Lane or Wave Sequence Step.
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Keyboard, Mod Sources, and Effects tabs
These let you edit the key and velocity zones, LFOs, Envelopes, Key Tracking, Mod Processors, and effects. You can 
drag from the mod sources here to modulate parameters in the main part of the screen, or even other modulation 
parameters; see “Drag and drop modulation routings” on page 8.

Set List window
This window shows all 64 Slots of a Set List. You can open multiple Set List windows at once. If one of the windows 
shows the Set List currently selected on the wavestate, the note “(Active)” appears after its name in the title bar.

Set List window

Slots selected for cut/copy/paste are outlined in blue “Active” shows Set List selected in “Settings”

The name of the Set List is shown both in the window’s title bar, and in an editable field at the top of the window.
As with the rest of the Editor/Librarian, any edits to Set Lists take effect immediately.
Selected Slots are shown with a blue outline. You can select multiple non-continuous Slots by holding down the 
command key on MacOS, or the Ctrl key in Windows. Alternatively, select a range of Slots by using Shift.
For detailed instructions about using this window, see “Editing Set Lists” on page 12.
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Menus

Application menu (MacOS only)
Preferences
Displays the Preferences dialog box, which contains two parameters: Performance Selection and Set List selection.

Performance Selection
Double-click in list selects on synth: Double-clicking a Performance in the Main Window selects the Performance on the 
wavestate. Single-click allows you to view and edit a Performance’s metadata without affecting the current sound on the 
wavestate. 
Select in list also selects on synth: Selecting a Performance in the Main Window also selects the Performance on the 
wavestate.
Use menu to select on synth: No actions in the Main Window will automatically select sounds on the wavestate. Only the 
Edit menu’s Select On Synth command will do so.

Set List Selection
Double-click in list opens editor: Double-clicking a Set List in the Main Window opens a Set List window for that Set 
List. No change is made to the current Set List selection on the wavestate. 
Double-click in list selects on synth and opens editor: Double-clicking a Set List in the Main Window both opens a Set 
List window for that Set List, and selects that Set List on the wavestate.
Use menu to edit or select on synth: No actions in the Main Window will automatically either open a Set List window, or 
select Set Lists on the wavestate. Only the Edit menu’s Open Editor and Select On Synth commands will do so.

About
This displays the software version of the wavestate Editor/Librarian.

File menu
Important: Many of these commands, including Import, Export, Export Bundle, Backup, and Restore, are 
available only when the Librarian window is displayed. If the Editor is displayed instead, these commands will 
be grayed out.

Save Performance…
This brings up a dialog to overwrite the current Performance.

Save As New Performance…
This brings up a dialog to save the current Performance as a new item, leaving the previous version intact.

Import…
Imports one or more files from disk. The data will be directly imported into the wavestate. For more information, see 
“Importing data” on page 10.

Export…
Exports the items selected in the Main Window (not a Set List window, if any are open) to individual files on disk. For 
more information, see “Exporting data” on page 10.

Export Bundle…
This command is available if multiple items are selected. It exports all the selected items to a single file on disk. This is 
convenient for distributing a set of sounds, for example.
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Backup…
Backs up the entire contents of the wavestate, including write-protected factory data, to a file on disk. For more 
information, see “Backing up all data” on page 11.

Restore…
Deletes the entire contents of the wavestate, including write-protected factory data, and then restores all data from a file 
on disk. For more information, see “Restoring data” on page 11.

Reset Global Utility Settings…
This restores the settings under the UTILITY button, such as the MIDI CC assignments, to their factory defaults.

Get Plug-in Coupon…
wavestate owners are eligible for a significant discount on the wavestate native plug-in. This command generates a 
coupon code tied to the wavestate hardware’s unique ID. An internet connection is required to generate the coupon.

Edit menu
Note: many operations apply only when editing Set Lists, and will be disabled otherwise. These include Cut, Cut and 
Shift Slots, Copy, Paste, and Insert Before. 

Undo
Returns to the state prior to the previous operation. This applies to any edits of metadata (such as names and 
categories), Set List edits, creation of new Set Lists, object duplication and deletion, and data Import. Note that 
restoring from a backup is not undoable. The system supports multiple undos, so that you can step backwards and 
forwards through a series of actions.

Redo
Returns to the state prior to executing the “Undo” command. The system supports multiple redos, so that you can step 
backwards and forwards through a series of actions. 

Delete
This removes the selected data. When used with Set List Slots, the Slots are changed to use the Init Performance. 
Note that factory data may not be deleted or changed. Also, there must always be at least one Set List; if there is only a 
single Set List in the system, it cannot be deleted.

Cut
This applies to Set List editing only. It cuts the selected Set List Slot(s), placing them on the clipboard, and changes them 
to use the Init Performance.

Cut and Shift Slots
This applies to Set List editing only. It cuts the selected Set List Slot(s), and shifts all other Slots to fill in the gap. The 
newly empty Slots at the end of the Set List will be filled by the Init Performance.

Copy
This applies to Set List editing only. It copies the selected Set List Slot(s), and places their data on the clipboard for use 
in Paste or Insert Before.

Paste
This applies to Set List editing only. It replaces the selected Set List Slot, and potentially subsequent Slots, with the data 
on the clipboard. 
If multiple Slots are selected, only the lowest-numbered selection affects the Paste operation; other selections are 
ignored. 

Important: if the clipboard contains multiple Slots, Paste will start with the first selected Slot and then replace 
as many Slots as necessary, regardless of how many other Slots are selected. For example, if there are four Slots 
on the clipboard, and you select Slots A3 and A7 and then Paste, Slots A3, A4, A5, and A6 will be replaced with 
the data from the clipboard.
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Insert Before
This applies to Set List editing only. It inserts the data on the clipboard into the Set List before the selected Set List Slot, 
and shifts subsequent Slots to make room. Slots at the end of the Set List will be “pushed off the end” and removed. 
As with Paste, if multiple Slots are selected, only the lowest-numbered selection affects the Insert Before operation; 
other selections are ignored. 

Duplicate
In the Main Window, this duplicates the selected item.

Select All
This selects all items shown in the front-most window, including either the main or Set List windows.

Deselect All
This clears any current selections in the front-most window.

New Set List
This creates a new Set List, with all Slots set to the Init Performance. It is available from the Main Window, when 
showing either All Data or Set Lists.

Open Set List Editor
When a Set List is selected in the Main Window, this opens a Set List window for that Set List. If multiple Set Lists are 
selected, it opens widows for each of them.

Select On Synth
When a Performance or Set List is selected in the Main Window, this selects the item on the wavestate. When an active 
Set List window is open, this selects the current Set List Slot. When an inactive Set List window is open, this selects the 
Performance assigned to the Set List Slot. 

Preferences (Windows only)
This shows the Preferences dialog. For more information, see “Preferences” on page 18.

View menu
Show Librarian
This switches the main window to show the Librarian. It’s the same as pressing the Librarian button in the upper right 
of the window.

Show Editor
This switches the main window to show the Editor. It’s the same as pressing the Editor button in the upper right of the 
window.

Zoom 50%…150%
This scales the entire Editor/Librarian window to be smaller or larger.

Devices menu
This menu shows the all of the wavestates connected to the computer, and selects one of them to be used by the 
Editor/Librarian. If there are multiple wavestates, you can change between them at any time. Note: when you change 
devices, the undo history will be cleared, and so undo/redo will no longer be available for past actions.
Data cannot be copied directly from one wavestate to another; instead, use Export to save the data from the first 
wavestate, and then Import to load the data into the second wavestate.

Important: Before connecting multiple wavestates, make sure to set each instrument’s System ID to a different 
number. For more information, see “Using the Editor/Librarian with two or more wavestates” on page 5.
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Windows menu
This menu shows all of the Editor/Librarian’s open windows. Select a window’s name to bring it to the front. 

Main Window
The Main Window is always shown at the top of the menu. Note that closing the Main Window will quit the 
Editor/Librarian application.

Set List Windows
Open Set List windows, if any, are listed below the Main Window.

Close All Set List Windows
This command closes all open Set List windows.

Close Current Set List Window
This command closes the front-most Set List window.

Help menu
Search field (MacOS only)
This brings up the standard search menu for system help, including the application’s menu commands.

About wavestate Editor/Librarian (Windows only)
This displays the software version of the wavestate Editor/Librarian.
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Troubleshooting

Software won’t start up
Make sure that your computer meets the operating requirements
See “Operating requirements” on page 1.

Check whether other applications might be running
If other applications are running, it is possible that they might somehow interfere with the wavestate Editor/Librarian. 
As a troubleshooting step, quit the other applications.

Can’t connect to the wavestate
Make sure that the wavestate is connected via USB
The Editor/Librarian requires USB, and cannot communicate with the wavestate over 5-pin DIN MIDI.

Try connecting the wavestate directly to your computer, without a USB hub
Faulty hubs may interfere with the connection. Hubs must support USB 2.0 or better.

Try a different USB cable
A faulty cable might interfere with the connection.

Confirm that the wavestate is running software version 2.0 or later 
To check the software version number, press UTILITY and then SHIFT + < (PAGE -).

Make sure that the wavestate has been detected by the connected computer
Windows 7/8/10: open the Device Manager (see the instructions under “Windows” on page 3) and check the 
“Other Devices” tab. If the wavestate does not appear, repeat the NCM or RNDIS configuration procedure.
Mac OS: open the System Preferences application, in the Applications folder. Go to the Network panel, and check the 
list of networks and network devices on the left of the window.

Make sure that the required network ports are not blocked by a software firewall
When communicating with the wavestate over USB, the Editor/Librarian uses TCP ports 50000 and 50001, and 
Bonjour uses UDP port 5353. These won’t be affected by an external firewall in a separate server or router, but can be 
blocked by a software firewall running on the same computer.

Disable VPN software
Some users have reported that VPN software may interfere with communication to the wavestate.

Windows: confirm that Bonjour is running
Open Services, find Bonjour Service in the list, and confirm that its Status is Running and Startup Type is set to 
Automatic.

Confirm that you have the latest version of the Editor/Librarian
You can download the latest version from the Korg website (http://www.korg.com/ ). 

Try restarting your computer
In some cases, the wavestate may not be immediately recognized after installation. If this occurs, simply restart your 
computer.
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Apple, Mac and the Mac logo, Bonjour, the Bonjour logo, and the Bonjour symbol are trademarks of Apple Inc., 
registered in the U.S. and other countries.
Windows 7, Windows 8.1 and Windows 10 are trademarks of Microsoft Corporation in the US and other countries.
All product names and company names are the trademarks or registered trademarks of their respective owners. 
Specifications and appearance are subject to change without notice for improvement.
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